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TRAIN THE TRAINER
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TRAIN THE TRAINER ESSENTIALS

COURSE CONTENT

Why Train the Trainer ?

Do you want to train an employee or employees to deliver your own training?
Having your own in-house trainer can be cost-effective for:
 Company-specific training (eg products)
 Needs that change with different delegates
 Delegate availability that is unpredictable or limited
You will examine the techniques and disciplines required for a training role, and develop communication
and key tutoring skills.
This programme focuses on the practical aspects of being a trainer. Learning is linked to workplace needs,
with tips and techniques being shared at each stage of the programme.
The result? You will be well-equipped to deliver quality training sessions that get the best results from
delegates.

Who Should Attend

The course is suitable for anyone new to a training position, who has been asked to take on training
responsibilities within their existing role, or even experienced trainers wishing to refresh skills.
No prior experience is necessary.

Course Outline

Introduction and Course Overview, Case Study
Communication Skills for Training
• Good Communicators • Your Role as an Effective Communicator

Questioning Skills for Trainers
• Open Questions vs Closed Questions • Probing: Digging Deeper • Questioning as a Training Technique

Listening Skills for Trainers
• Your Listening Skills • Active Listening Skills in Training Sessions

Presentation Skills in Training
• Presentation Tips • Telling vs Showing • Overcoming Nerves

Developing Participation in Training
• Removing Barriers to Participation • Enhancing Participation

Managing Questions and Answers
• Objectives of the Question and Answer Period • Guidelines for Handling Questions

Games: Adding Fun and Humour
• The Use of Games • Types of Games • Getting Buy-In • Troubleshooting: When Games Go Wrong • Quick
and Easy Games
Dealing with Difficult Trainees: • Characteristics of Difficult Delegates, examples, case studies, role plays
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TRAIN THE TRAINER: LESSON PLANNING

COURSE CONTENT

Course Aims

This intensive, hands-on one-day workshop deals with the process of developing a training programme.
By the end of this workshop, delegates will be able to:

 Recognise when a training need exists for an organisation
 Understand the basic rules of designing a training programme
 Write clear, concise training objectives
 Incorporate relevant methods into the design of a training session
 Know how and where to research training content
 Create evaluation strategies
 Use Kirkpatrick's Four Levels of Evaluation

Who Should Attend

The course is designed for trainers and HR professionals who want to develop programmes that are
meaningful, practical, and will benefit both trainees and the organisations they work for.

Course Outline

Introduction and Course Overview
The Need for Training
• Organisational Objectives • When is Training Necessary? • Defining Training Needs • ICE: Analysis in
Three Steps

Basic Rules of Programme Design
• Moderation • Balance • Involvement • Continue Your Learning • The Need for Collaboration

SMART Objectives
• Defining SMART • The Three Ps • Exercise: Improving Goals

Learning Objectives
• Determining Objectives • Considerations When Writing Objectives • Types of Objectives: KSAs • Setting
the Scope • Exercise: Verbs for Writing Clear, Concise Training Objectives • Developing Objectives

Designing a Training Session
• Training Methods • Constraints on Methods Used • Designing a Learning Sequence

Researching and Developing Content
• Researching Content • Exercise: Availability of Information in Your Area of Training

Tips for Good Training Design
• Elements of Good Training Design

Evaluation Strategies
• The Basics of Evaluation • Evaluation Methods

Four Levels of Evaluation
• Level One: Reaction • Level Two: Knowledge (Learning) • Level Three: Transfer of Learning (Behaviour) •
Level Four: Impact (Results)
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TRAIN THE TRAINER: FOR THE MORE EXPERIENCED

COURSE CONTENT

Course Aims

This intensive, hands-on one-day workshop teaches delegates how to deliver training courses in a way that
will make them interesting, enjoyable and highly effective. Delegates will learn to:

 Use team teaching and develop participation
 Understand the use of visual aids and supporting materials
 Use games to add fun and humour
 Deal with difficult situations, conflict and difficult delegates

Who Should Attend

The course is designed for trainers, both new and experienced, who want to improve their delivery skills in a
structured and organised way so that the courses they run will be more enjoyable and much more
productive.

Course Outline

Introduction and Course Overview
Setting the Climate
• Simple Rules to Make the Session Positive

Team Teaching
Developing Participation in Training
• Removing Barriers to Participation • Enhancing Participation

Managing Questions and Answers
• Objectives of the Question and Answer Period • Guidelines for Handling Questions

Visual Aids
• Benefits of Visual Aids • Popular Visual Aids • Other Types of Visual Aids • Background Considerations •
Exercise: Visual Aids and Your Training

Supporting Materials
• Delegate Workbooks • Handouts • Exercise: Supporting Materials for Your Training

Games: Adding Fun and Humour
• Humour • The Use of Games • Types of Games • Getting Buy-In • Troubleshooting: When Games Go
Wrong • Quick and Easy Games

Difficult Situations: An Overview
• Potential Problems with Training Sessions

Managing Conflict in Training
• Warning Signs of Conflict • Causes of Conflict in Training

Managing Difficult Situations and Difficult delegates
• Your Toolkit for Dealing with Difficult Situations • Confronting Difficulties • Characteristics of Difficult
Delegates, examples, case studies, role plays
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TRAINING NEEDS ANALYSIS

COURSE CONTENT

Training Needs Analysis

Training and Development is crucially important to the success of an organisation at all levels. It can and
should be a powerful, positive process that helps individuals, groups and the whole organisation. Yet
Training Needs Analysis (TNA) can be construed as expensive, or misunderstood, and not planned in a
wider context of change and growth. It is necessary to recognise the value of properly implemented TNA in
order to provide appropriate, cost-effective training that develops and motivates staff.

Course Aims

This intensive, hands-on, one-day workshop, delegates will explore how to accurately identify the training
and development needs of three elements: the organization, the occupational groups within it and the
individuals working there. They will look at each of the three in turn and work through approaches that are
common to all, or unique to one.

Who Should Attend

All managers or supervisors, whether in an HR or line management role, who want an understanding of the
purpose and principles of Training Needs Analysis that will form the basis of an ongoing development
process for their staff.

Course Outline

Introduction and Course Overview
The Overall Picture
• Defining Training and Development Needs • Where Training Needs Occur • Whose Job Is It Anyway?

The Organisation
• The Systematic Approach • Organisation Development • Administrative Approach • Welfare Approach •
Political Approach • Your Approach

Current Needs
• Current Versus Future Needs • Routine Monitoring • Investors In People Surveys • Discussions and
Interviews • Your Experience

Occupations and Jobs
• Functional Analysis • Job Analysis • Task Analysis

The Individual
• Individual Training and Development Needs • Prioritising • Learning Requirements • Interviews

Bringing It All Together
• The Investors In People Action Plan • Planning to Meet the Needs • Avoiding Discrimination •
Organisational Requirements
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PRESENTATIONAL SKILLS
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ESSENTIAL PRESENTATION SKILLS

COURSE CONTENT

Course Aims

This intensive one-day workshop teaches delegates the essential skills necessary to plan and build
presentations, then to deliver them in the most effective way.

Who Should Attend

Anyone who needs to present to audiences in any environment. The course focuses on a wide range of
topics and will be extremely useful to new and experienced presenters alike.

Course Outline

Preparing Your Presentation: Overview
• Setting Your Objectives (Answering the WHY) • Knowing Your Audience (Answering the WHO) • Building
the Structure (Answering the WHAT)

Setting Your Objectives
• What Are You Trying To Do? • Identifying your Objective • Discussion

Knowing Your Audience
• A Basic Definition of your Audience • Understanding Your Audience • Focus, Plan, and Convey • Audience
Profile

Building the Structure
• The Consequences of Bad Preparation • The Three Benefits of a Plan • Presentation Structure: an
Overview

Timing Your Presentation
• How to prevent over-running

Overview of Communication
• The Three Parts of Communication • Your Competition

Controlling Your Nerves
• Overcoming Your Fears • Thinking Positive • Being Realistic • Taking Control • Sticky Situations • Paying
Attention to Your Appearance • Tips to Combat Nerves • Nervousness Presentation

Our Body Language
• First Impressions • Non Verbal Factors of Communication • Avoiding the Traps

The Importance of Voice
• Factors Affecting the Voice • Achieving Optimum Conditions for Speech • Using Your Voice

Presentations
• Presentation Preparation • Presentation Delivery • Presentation Evaluation
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PRESENTATION SKILLS BASICS : 12X 2 HOURS OVER 12 WEEKS, ON-SITE

COURSE CONTENT

Course Aims

This intensive half-day workshop has been designed to improve key skills, and also to help delegates to
control their nerves, so they they will deliver much better presentations more easily.

Who Should Attend

Anyone who needs to present to audiences in any environment, whether at sales events or in meetings or
seminars.

Course Outline

Introduction and Course Overview
Overview of Communication
• The Three Parts of Communication • Your Competition

Presentation: First Impressions
• First impressions last

Controlling Your Nerves
• Overcoming Your Fears • Thinking Positive • Being Realistic • Taking Control • Sticky Situations • Paying
Attention to Your Appearance • Tips to Combat Nerves • Nervousness Presentation

Our Body Language
• First Impressions • Non Verbal Factors of Communication • Avoiding the Traps

The Importance of Voice
• Factors Affecting the Voice • Achieving Optimum Conditions for Speech • Using Your Voice

The use of Language
Working with props
Using the stage
Telling a story
Inspiring your audience
Influencing your audience
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PROJECT MANAGEMENT
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THE NEW PROJECT MANAGER

COURSE CONTENTProject Management isn’t just for construction engineers and military logistics experts any more. Today, inaddition to the regular duties of your job, you are often expected to take on extra assignments - and to get thatadditional job done well, under budget, and on time. Whether you are a full time Project Manager, or part of yourjob requires the effective completion of projects, you need Project Management skills.
Course AimsThis intensive one-day training course teaches delegates basic project management techniques, and is intendedto familiarise delegates with the most common terms and the most current thinking about projects. It will alsoprovide the basic knowledge required to attend more advanced project management courses.
Who Should AttendThis one day workshop is targeted at new or intended Project Managers, administrators or support staff whohave little or no knowledge of project management techniques, but have become involved with projects. Theyneed to acquire a basic understanding in the shortest possible time.
Course OutlineCourse Overview and Learning ObjectivesDefining Projects and Project Management: • What is a Project? • What is Project Management? • Who are theKey Players?The Role of a Project ManagerEight Aspects of a ProjectHow Can Projects Help Me?• The Benefits of Projects • Case StudyA Project’s Life Cycle: • The Four Phases of a Project • Milestones • Why do Projects Fail? • Three Ways to End aProjectSelling a Project: • Tom Peters • The Priority MatrixCreating a VisionProject Goals: • SMART Goals • Your Project’s GoalsUsing a Target ChartPreparing Your ProjectLaying out the Project• The SOW • The Purpose Statement • The Scope Statement • The Project Deliverables • The Goals and Objectives• SWOT Analysis • Cost and Schedule Estimates • List of Stakeholders • The Chain of Command • Assumptionsand Agreements • The Communication Plan • Individual SOW • Project Planning Worksheet
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PROJECT MANAGEMENT ESSENTIALS

COURSE CONTENT

Course AimsThis highly intensive one-day training course teaches delegates basic project management techniques,and is intended to familiarise delegates with common terms and tools so that they can manageprojects more effectively.
Who Should AttendAnyone with little or no knowledge of project management tools or techniques, but who has becomeinvolved with projects and needs to acquire a basic understanding in the shortest possible time.
Course OutlineCourse Overview and Learning ObjectivesDefining Projects and Project Management• What is a Project? • What is Project Management? • Who Are the Key Players?How Can Projects Help Me?• The Benefits of Projects • Case StudyA Projects Life Cycle• The Four Phases of a Project • Milestones • Why do Projects Fail? • Three Ways to End a ProjectProject Goals• SMART Goals • Your Project’s GoalsUsing a Target ChartPreparing Your ProjectWhat Really Needs to be Done?• Identifying Tasks • Identifying ResourcesThe Work Breakdown Structure• About MilestonesScheduling and Planning• Preparing a Basic Schedule • Float Time • Scheduling Checklist • Activity Scheduling • Planning Tools • ActionPlanning Worksheets • Milestone Charts • PERT • Along the Critical Path • Gantt Charts • The Network Diagram •Five Steps to Create a Network Diagram • The Flow ChartProject Risks• Types of Risks • Five Steps to Deal With RisksExecution Phase• Maintaining the Rhythm • The 95% PhenomenonClosing Out a ProjectA Personal Action Plan
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PROJECT MANAGEMENT INTERMEDIATE

COURSE CONTENT

Planning and ControlOnce a project has been set up correctly, the work needs to be planned, executed and controlled in response toevents. In order to do this effectively, it is necessary to be familiar with a range of tools that assist in thesuccessful implementation of the plan.
Course AimsThis intensive one-day training course builds on the fundamentals taught in our Project ManagementIntroduction course. It takes delegates through the remaining three stages of the project lifecycle: planning,execution, and termination, providing the knowledge required for the technical aspects of managing a project.
Who Should AttendThis workshop is intended for those who understand the conceptual phase of a project’s life cycle, includingsetting goals, creating a vision statement, and creating the Statement of Work. They should have attended theProject Management Introduction course or be fully familiar with the subjects it covers.
Course OutlineCourse Overview and Learning ObjectivesWhat Really needs to be Done? • Identifying Tasks • Identifying ResourcesThe Work Breakdown Structure. • MilestonesScheduling and Planning • Preparing a Basic Schedule • Float Time • Scheduling Checklist • Activity Scheduling •Planning Tools • Action Planning Worksheets • Milestone Charts • PERT • Along the Critical Path • Gantt Charts •The Network Diagram • Five Steps to Create a Network Diagram • The Flow ChartBudgeting BasicsProject Risks: • Five Steps to Manage RiskPreparing the Final PlanMaking it Fit: • Schedule and Budget Compression • Compressing the Schedule • Compressing the Budget • CaseStudyThe Execution Phase: • The Execution Phase • Maintaining the Rhythm • The 95% PhenomenonControlling ChangesClosing out a Project: • Closing Out A Project • Lessons Learned
Learning ObjectivesBy the end of the day, delegates will be able to:
 Identify your project’s tasks and resources
 Order tasks using the Work Breakdown Structure
 Schedule tasks effectively
 Use basic planning tools such as a Gantt chart, PERT diagram, and network diagram
 Prepare a project budget
 Modify the project budget and schedule to meet targets
 Identify and manage risks
 Prepare a final project plan
 Execute and terminate a project
 Develop and manage a change control process
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PROJECT MANAGEMENT ADVANCED

COURSE CONTENT

Managing TeamsIt’s easy to forget the “manager” part of your “project manager” title amongst all the activity during a project.However, it is crucial that you hone your management skills as they are an important part of your success as aproject manager.
Course AimsThis intensive one-day course focuses mainly on the man-management skills associated with the job. It alsocovers some advanced project management techniques that you can master to help bring your projects to thenext level.
Who Should AttendDelegates should have a thorough understanding of the technical aspects of project management, includingtopics such as preparing a statement of work, setting project goals, scheduling, budgeting, managing projectrisks, and executing a project.
Course OutlineCourse Overview and Learning ObjectivesChoosing the Project Team• Choosing the Team • Project Skills Review • Four Issues to Address with Project TeamsBuilding a Winning Team• Why is Teamwork Important? • The Four Stages of Team DevelopmentTeam Meetings• Team Meetings • Setting the Tone • Status Meetings • Meeting BasicsNine Easy Ways to Reward Your Team• Nine Easy Ways to Reward Your TeamDeveloping a Communication Plan• The Five Components of a Communication Plan • Case StudyCommunicating with Sponsors and Executives• Communicating with Sponsors and Executives • Communication Tips • Role PlayDealing with Problem Team Members• Dealing with Problem Team Members • Common Situations • Group Exercise
Learning Objectives

 By the end of the day, delegates will be able to:
 Think critically when choosing a project team
 Make the best of an assigned project team
 Help teams move through various stages to become a high-functioning machine
 Maximise productivity at team meetings
 Reward and motivate your team
 Develop and execute a communication plan
 Communicate with sponsors and executives more effectively
 Identify problem team members and strategies for working with them
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MICROSOFT PROJECT INTRODUCTION

COURSE CONTENT

Course AimsThe objective of this intendive, hands-on one-day training course is to provide delegates with a thoroughunderstanding of the concepts and terminology used in Microsoft Project . Understanding the resource drivenelement of Microsoft Project and the alternative ways of using the software is the core benefit of this course.Following the course delegates will be able to able to produce both timeline and resource driven plans.
Who Should AttendThe course is aimed at new users of Microsoft Project who want to familiarise themselves with the basicconcepts of the software in order to build project plans. Also existing users of the software who need a betterunderstanding of the terminology used and need to prepare project plans based on resources and work. Note :No previous experience of either project management or the software is required, but due to the interactivenature of the course delegates should have a high level of competency in using Microsoft Windows.
Course OutlineIntroduction and Course Overview
Terminology: • What is the Critical Path? • What is a Critical Task? • Critical Path Calculation • Definition ofSlack • Multiple Critical Paths • Overall Critical Path
How Microsoft Project Schedules: • Auto and Manual Scheduling • Effort Driven Scheduling • Duration-Work-Units • Views-Tables-Filters • Milestones • Task Relationships • Lead & Lag Times
Setting Tasks to Manual Scheduling: • Setting Projects to Auto Schedule & Effort Driven
Overview of Microsoft Project : • Command Tabs • Short Cuts • ScreenTips • File Architecture • Organizer •Changing the Timescale • Timescale Options • Non-Working Time Tab • System Options • Filters • Help •Indicators • Hyperlinks
Task Information Dialog Box: • Task Information – General; Predecessors; Resources; Advanced; Notes;Custom Fields
Creating a Project

Setting the Environment

Outlining a Project: • Project Summary Task
Resource Driven Projects: • Resource Driven Projects • Question Marks
Resources: • Resource Sheet • Resource Information Dialog Box • Cost Table Selection • Assigning Resources •Deleting Resources • Resource Over Allocation
Task Usage and Resource Usage Views: • Task Usage View • Resource Usage View
Scheduling Issues: • Who Drives the Schedule? • Overtime • Extending the Working Day
Creating a Project – 11 Key Steps

Task Constraints: • Setting Soft & Hard Constraints
Scheduling Conflicts

Deadline Dates: • Deadline Indicator • Missed Deadline Alert
Project Timeline

Printing Reports: • Overview of Views and Reports • Printer Settings • Page Setup
Case Studies: • Creating a Timeline Project • Creating a Resource Driven Project
Overview: Microsoft Project Ribbons
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MICROSOFT PROJECT COURSES

COURSE CONTENT

Course AimsThe objective of this intensive, hands-on one-day training course is to provide delegates with athorough understanding of the advanced functionality of Microsoft Project 2010. Upon successfulcompletion of the course, delegates will be able to able to use complex calendars, consolidate plans,share resources, base plan, track projects and customize Microsoft Project 2010.
Who Should AttendThe course is intended for existing users of Microsoft Project 2010 who want to use the moreadvanced features of the software in order to increase their knowledge, productivity and effectiveness.Delegates should have a good working knowledge and understanding of the concepts covered in theIntroduction course.
Course OutlineCreating Projects• Timeline Projects • Resource Driven ProjectsSetting Projects to Auto Schedule & Effort DrivenComplex Calendars• Base Calendars • Resource Calendars • Task CalendarsSubprojects• SubprojectsResource Pools• Resource Sharing • Reviewing WorkloadsTracking• Setting the Baseline • Tracking • Updating Tasks • Updating Actual Work • Updating a Project • Clearing theBaselineAdvanced Topics• Recurring Tasks • Task Splitting • Network Diagram • Node Layout • Gantt Chart – Customize • Gantt Chart –Insert Notes • Sort Projects • Ribbons • Custom Fields • New Views • Tables • Filters • AutoFilters • Group Filters• Define Group Structure • Global File • Default ViewOverview: Microsoft Project 2010 Ribbons• Microsoft Project Ribbons
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MANAGEMENT SKILLS
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SALES MANAGEMENT INTRODUCTION

COURSE CONTENT

Course AimsThis intensive one-day training course teaches the fundamentals of sales team management. Delegateswill learn how to be successful sales managers, select sales professionals, build unity and trust in asales team, interview successfully, train sales professionals, set performance standards, and conductperformance evaluations. Course activities also cover choosing a territory strategy, conductingterritory reviews, developing and using sales forecasts, conducting sales meetings, and setting goals inmeetings. Delegates will also learn how to motivate sales team members, implement compensationpractices to keep top performers, identify and improve substandard performance.
Who Should AttendNew, existing or potential sales managers who want to acquire or refresh sales management skills in astructured manner in the shortest possible time.
Course OutlineEffective Sales Teams• Managing sales • Selecting sales professionals • Building relationships • Building trust in sales teamsEffective Sales Performance• Training sales professionals • Sales performance • Sales meetingsManaging Sales Territories• A territory strategy • Conducting territory reviewsForecasting Sales Revenue• Understanding sales forecasts • Developing forecastsMotivating Sales Teams• Motivating sales professionals • Measuring motivation levels • Improving sales performanceA Personal Action Plan
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MANAGING STAFF PERFORMANCE

COURSE CONTENT

Course Aims

To provide a good understanding of the principles of leadership and the processes / skills required for
effectively managing staff performance.

Who Should Attend

All those who have responsibility for managing staff.

Course Outline

Leadership versus Management
• Adairs Top Leadership Qualities • Action Centred Leadership • Management Styles

Giving Feedback
• Receiving Feedback • Assertiveness, Aggressiveness And Passivity • Assertiveness – The 3 Steps •
Assertiveness And Feedback Exercise

Setting S.M.A.R.T. Objectives
• Measurability of Objectives • Defining Standards Exercise

Performance Management
• Skill / Will Matrix • Applying the Skill/Will Matrix • Managing Poorer Performance • Overcoming
Performance Blockages

Managing Poor Performance
• Performance Counselling Meeting • Performance Counselling Meeting: Preparation • Undertaking The
Performance Counselling Meeting • Performance Counselling Meeting Process • Exercise: Friday the 13th !
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DATABASE
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RELATIONAL DATABASES & DATA MODELLING OVERVIEW TRAINING
COURSE

COURSE CONTENTS - DAY 1

COURSE INTRODUCTION

 Administration and Course Materials
 Course Structure and Agenda
 Delegate and Trainer Introductions

SESSION 1: INTRODUCTION TO RELATIONAL
DATABASES

 The Database Approach
 Database Management Systems
 The function of a Database ManagementSystem
 The Processing Architecture
 The Schema Architecture
 The Storage Architecture
 An overview of Database SystemDevelopment
 An overview of general databaseprinciples

SESSION 2: CONCEPTUAL DATA MODELS

 Overview of Entity Models
 Entities and how to identify them
 Attributes and how to identify them
 Relationships and their qualities
 Building an Entity Relationship Diagram
 Resolving many-to-many relationships
 Sub-type and Super-type Relationships
 Arc Relationships
 Recursive Relationships
 Constraints and Assumptions
 Normalisation to the First Normal Form(1NF)
 Normalisation to the Second NormalForm (2NF)
 Normalisation to the Third NormalForm (3NF)
 Exercises: Analysing a specification

o Creating an Entity RelationshipDiagram from it
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RELATIONAL DATABASES & DATA MODELLING OVERVIEW TRAINING
COURSE

COURSE CONTENTS - DAY 2

SESSION 2: CONCEPTUAL DATA MODELS
(CONTINUED)

 Normalisation to the First Normal Form(1NF)
 Normalisation to the Second NormalForm (2NF)
 Normalisation to the Third NormalForm (3NF)
 Exercises: Data Normalisationproducing table specifications andEntity Diagrams

SESSION 3: THE RELATIONAL MODEL

 Relational Structure
 Relational Terminology
 Domains
 A Relational schema
 Candidate keys and Primary Keys
 Foreign Keys
 Key Constraints
 Attribute Constraints
 Implementing Sub-type/Super-typeRelationships
 Views
 Denormalisation using Pre-joinedTables
 Denormalisation using Derived Data
 An Introduction to Structured QueryLanguage (SQL)
 Simple Queries
 Simple Updates of the Data
 Exercise: Data Modelling from anInvitation to Tender
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INTRODUCING SQL

COURSE CONTENTTo provide the knowledge and skills needed to retrieve and update data held in a relational database.
WHO SHOULD ATTENDAnyone who needs to understand and use SQL to manipulate a database.There are no formal pre-requisites for this Introduction to SQL course, although an understanding ofdatabases and exposure to information technology in general would be useful.
COURSE OUTLINE

Relational Database Concepts• What is a Relational Database? • Tables, Rows and Columns • Indexes, Primary Keys and ForeignKeys • Data Types • The Data Dictionary • Getting Started
SQL Language Essentials• The Select Statement • The Select and From Clauses • Conditions and the Where Clause • The OrderBy Clause • Arithmetic Operations • Column Aliases • Practical Exercises
Summarising and Grouping Data• Aggregate Functions • The Group By Clause • The Having Clause • Practical Exercises
Querying Multiple Tables• Joining Tables • Inner Joins • Column Qualification and Table Aliases • Outer Joins • SelfJoins • Alternative Join Syntax • Practical Exercises
Additional SQL Features• Combining Queries • The Union, Intersect and Minus Operators • Basic Subqueries • PracticalExercises
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INTRODUCTION TO MYSQL TRAINING COURSE DAY1

COURSE CONTENTS - DAY 1  COURSE INTRODUCTION

 Administration and course materials
 Course structure and agenda
 Delegate and trainer introductions

SESSION 1: DATABASE CONCEPTS
 What is a database?
 Database management systems
 Tables, rows and columns
 Indexes, primary keys, unique constraints and foreign keys
 Client-Server architecture
 Supported data types
 Storage engines and table types
 The Information_Schema and MySQL Databases
 Exercise: Using a MySQL Database

SESSION 2: USING THE MYSQL CLIENT
 What is the MySQL client?
 Getting started and Logging in
 Selecting a database
 Client commands
 Entering and executing SQL statements
 Retrieving previous commands
 Creating, editing and executing SQL files
 Redirecting output into a file
 Command line execution of MySQL Scripts
 Exercise: Using the MySQL Client

SESSION 3: BASIC SELECT
 The SQL SELECT statement
 Case sensitivity
 Quotes
 Statement terminator
 Syntax conventions
 The select clause
 The FROM clause
 Conditions and the WHERE clause
 Logical operators
 The ORDER BY clause
 Column aliases
 Arithmetic expressions
 Precedence of operators
 Exercises: Querying the sample database

SESSION 4: LIMIT, UNION AND AGGREGATE FUNCTIONS
 The LIMIT clause
 UNION
 UNION ALL
 Aggregate functions
 The GROUP BY clause
 Using Rollup with GROUP BY
 The HAVING clause
 Exercises: Using Limit, Union and Aggregate Functions
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INTRODUCTION TO MYSQL TRAINING COURSE DAY 2

COURSE CONTENTS - DAY 2

SESSION 5: SUBQUERIES AND JOINS

 Subqueries
 Cartesian products
 Joins with original syntax
 Table aliases
 Natural joins
 Join using
 Join on
 Multi-table joins
 Exercises: Using Subqueries and Joins

SESSION 6: NUMERIC AND CHARACTER FUNCTIONS

 Function types
 Testing functions
 Numeric functions
 Character functions
 Exercise: Using Numeric and Character Functions

SESSION 7: DATE, TIME AND OTHER FUNCTIONS

 Date and time column types
 Date and time formats
 The date format function
 Functions to return date time
 Functions to extract components from date time
 Date time arithmetic
 Miscellaneous functions
 Exercise: Using Date, Time and other functions

mailto:smBarnard_de@live.de
www.pcworkshops.wordpress.com


Sarah Barnard Training venue:
+44 (0) 7784 357309 25 Northumberland Ave,
smBarnard_de@live.de www.pcworkshops.wordpress.com
Page 29 21.05.2013

INTRODUCTION TO MYSQL TRAINING COURSE DAY 3

COURSE CONTENTS - DAY 3

SESSION 8: DATABASES AND TABLES

 Creating a database
 Selecting a database
 Creating tables
 Auto_increment
 Show create table
 Column operations
 Constraint operations
 Copying tables
 Renaming tables
 Changing engine for tables
 Dropping tables
 Temporary tables
 Exercises: Maintaining databases andtables

SESSION 9: INDEXES AND VIEWS

 What is an index?
 Creating an index
 Reviewing indexes
 Dropping indexes
 What is a view?
 Creating views
 View restrictions
 Dropping views
 Exercise: Maintaining indexes and views

SESSION 10: MANAGING DATA

 Inserting rows
 Replacing rows
 Updating rows
 Deleting rows
 The truncate statement
 The COMMIT and ROLLBACK commands
 Savepoints
 Implicit commits
 Exercise: Managing data

SESSION 11: ACCESS CONTROL

 Creating users
 Renaming users
 Dropping users
 Granting privileges
 Revoking privileges
 Exercise: Creating users, granting andrevoking

SESSION 12: IMPORT AND EXPORT

 Exporting using SQL
 Importing using SQL
 Exporting from the command line
 Importing from the command line
 Exercise: Export and import data
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MICROSOFT OFFICE ACCESS INTRODUCTION

Course Aims

This intensive one-day training course is designed to enable users to get to grips with the main features of
Microsoft Access , including a thorough treatment of the new 'Ribbon' interface. It is entirely 'hands on', so
delegates will get practice in using the software in a realistic and practical way.

Who Should Attend

The course is intended for new users of Microsoft Office Access who want to become productive in the
shortest possible time. Delegates should be proficient in using a PC with the Microsoft Windows operating
system, but no prior experience with Access is required.

Course OutlineGetting Started with Access
• Starting Out • Interface Basics • Database Security • Getting HelpThe New Ribbon Interface
• The Quick Access Toolbar • Basics of Tabs • The Home Tab • The Create Tab • The External Data Tab •
The Database Tools TabCreating a Simple Database
• First Steps in Database Creation • Database Records • Creating a Table • Formatting TextForms; Queries; Reports and Filters
• Creating and Using Forms • Creating and Using Queries • Creating and Using Reports • Sorting and
Filtering Data • Viewing Data • Printing a Database Object
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MICROSOFT OFFICE ACCESS INTERMEDIATE

Course Aims

This intensive, hands-on one-day training course has been designed to give delegates a solid understanding
of more advanced Access tools and concepts in order to increase their knowledge and productivity.

Who Should Attend

Users with a basic understanding of Microsoft Office Access who want to consolidate and expand on their
knowledge of the basic features in a short space of time. Delegates should have a good working knowledge
and understanding of the concepts covered in the Introduction course.

Course OutlineAdvanced File Tasks
• Using Windows Explorer within Access • Database Management • Saving Your Files • Exporting Files •
Linking FilesWorking with Tables
• Customising Tables • Table Properties: Formatting • More Table Properties • Data Validation and Lookup
WizardWorking with Forms
• Basic Form Controls • Advanced Form Controls • Formatting Your Form • Formatting Controls • Using
ThemesWorking with Reports
• Organizing Report Data • Formatting Reports • Common Report TasksWorking with Queries
• Basic Queries • Doing More with Queries • Creating Advanced Queries • Creating Management (Action)
Queries
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MICROSOFT OFFICE ACCESS ADVANCED

COURSE CONTENT

Course Aims

This intensive hands-on one-day training course has been designed to provide delegates with a solid
understanding of advanced tools and concepts in Access in order to increase their knowledge and
productivity.

Who Should Attend

Users with a good understanding of Microsoft Office Access who want to expand on their capabilities in a
short space of time. TSome of the lessons are quite technical and delegates must have a good working
knowledge and understanding of the concepts covered in the Introduction and Intermediate courses.

Course Outline

Advanced Data Management
• Referential Integrity • Table Relationships • An Introduction to SQL • Modal Dialog BoxesAdvanced Form Tasks
• Using Subforms • Creating a Navigation Form • Advanced Form Controls • Exporting a Form • Other Form
TasksPivoting Data
• Creating a PivotTable • Using PivotTables • Advanced PivotTable Tasks • Creating a PivotChart • More on
PivotChartsSQL and Microsoft Access
• Understanding SQL • Using the SELECT Statement • Using Subqueries • Using SQL Joins
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FUNDAMENTALS OF JAVA PROGRAMMINGThe Fundamentals of Java Programming course introduces delegates to programming using the Javalanguage. It explains the concepts of programming using the Java technology stack and gives delegatesa practical introduction to the Java landscape.
SKILLS GAINEDThe delegate will practise:

 Object-oriented analysis
 Basic programming techniques
 Using classes and methods
 Using variables
 Using operators and loop constructs
 Using encapsulation and constructors
 Using inheritance and arrays

WHO WILL THE COURSE BENEFIT?The Fundamentals of Java Programming course is aimed at beginners to programming that wish tolearn the Java language. From technical writers and managers to administrators with a non-technicaland non-programming background. The course is also of benefit to those wishing to begin their studytowards the Oracle Certified Java Associate Exam (OCJA), being aimed at those that wish to beginlearning Java practically and at a steady pace.
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JAVA PROGRAMMING INTERMEDIATE

COURSE CONTENTS - DAY 1
SESSION 1: JAVA TECHNOLOGY PRIMER

 Key Concepts of the Java Language
 Java Technology Landscape
 Understanding the Product Lifecycle
 Setup the Java SE Development Kit

SESSION 2: PACKAGE, COMPILE, INTERPRET

 Understanding Packages
 Understanding Package-Derived Classes
 Compiling and Interpreting Java Code

SESSION 3: DEVELOPING AND TESTING A JAVA
PROGRAM

 Creating Classes
 Compile and Run Command LinePrograms
 Run Applications using the Main Method
 Moving from Procedural to ObjectOriented Java

SESSION 4: PROGRAMMING WITH JAVA
STATEMENTS

 Assignments
 Conditional Statements
 Algorithms and Pseudo-Code

COURSE CONTENTS - DAY 2
SESSION 5: JAVA OPERATORS AND STRINGS

 Assignment Operators
 Arithmetic Operators
 Relational Operators
 Logical Operators
 String Objects and Methods

SESSION 6: UNDERSTANDING METHODS

 Declare and Invoke Methods
 Methods with Return Types
 Overloading Methods
 Overriding Methods
 Method Outputs

SESSION 7: BASIC CLASSES AND VARIABLES

 Understand Primitives
 Primitive Wrapper Classes
 Understand Enumerations

SESSION 8: VARIABLE SCOPE AND CLASS
CONSTRUCTION

 Local Variables
 Method Variables
 Instance Variables
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COURSE CONTENTS - DAY 3
SESSION 9: DECLARE, INITIALIZE AND USE
VARIABLES

 Understand Variable Syntax
 Use Java Primitive Variables
 Declare, Initialise and Utilise Variablesand Constants
 Adhere to Coding Standards
 Use of Java Operators
 Type Casting and Promotion

SESSION 10: LOOP CONSTRUCTS

 Create and Use While Loops
 Create and Use For Loops IncludingFor/Each Syntax
 Create and Use Do/While Loops

SESSION 11: CREATE AND USE OBJECTS

 Declare, Instantiate, and Initialize ObjectVariables
 Understanding Java Objects
 Understanding Java Enumerations
 Strong Typing

SESSION 12: USING ARRAYS

 Building One-Dimensional Arrays
 Setting Array Values and LoopingThrough Arrays
 Array Methods and Properties
 Building Two-Dimensional Arrays
 Array Examples

COURSE CONTENTS - DAY 4
SESSION 13: CLASSES AND RELATIONSHIPS

 Class Compositions and Association
 Class Relationships
 Multiplicities
 Examples of Classes and Relationships

SESSION 14: UNDERSTANDING INHERITANCE

 Inheritance and Class Type
 Overriding Methods
 Abstract Classes
 Interfaces
 Examples of Inheritance andEncapsulation

SESSION 15: ENCAPSULATION AND
CONSTRUCTORS

 Data Protection Through Encapsulation
 Access Modifiers
 Object Initialisation with Constructors

SESSION 16: UNDERSTANDING POLYMORPHISM

 Polymorphism Explained
 Inheritance and Interface Polymorphism
 Coding to the Interface
 Examples of Polymorphism
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COURSE CONTENTS - DAY 5
SESSION 17: UML TO REPRESENT OBJECT-
ORIENTED CONCEPTS

 Class, Abstract Class and InterfaceDiagrams
 Attributes and Operations
 Create Basic UML Diagrams
 Recognise UML Associations

SESSION 18: JAVA PLATFORMS AND
INTEGRATION TECHNOLOGIES

 Multiple Tiers for Java: JSE, JME, JEE
 High Level Overview of Java RemoteMethod Invocation (RMI)
 High Level Overview of Java DatabaseConnectivity (JDBC)
 Understand the Use of Java IntegrationAPI's

SESSION 19: UNDERSTANDING JAVA CLIENT-SIDE
TECHNOLOGIES

 Thin Clients Technologies (HTML andJavaScript)
 JME MIDlets
 Java Applets
 Java Swing

SESSION 20: UNDERSTANDING JAVA SERVER-SIDE
TECHNOLOGIES

 JEE Tiers and Technologies
 Server Side Components and Options
 Java Dynamic Web Components
 Business Tier Components

mailto:smBarnard_de@live.de
www.pcworkshops.wordpress.com


Sarah Barnard Training venue:
+44 (0) 7784 357309 25 Northumberland Ave,
smBarnard_de@live.de www.pcworkshops.wordpress.com
Page 38 21.05.2013

MICROSOFT OFFICE
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MICROSOFT OFFICE POWERPOINT INTRODUCTION

COURSE CONTENT

Course Aims

This intensive one-day training course is designed to enable users to get to grips with the main features of
Microsoft PowerPoint 2007 or , including a thorough treatment of the 'Ribbon' interface, introduced with
Powerpoint 2007. It is entirely 'hands on', so delegates will get practice in using the software in a real life and
practical way.

Who Should Attend

The course is intended for new users of Microsoft PowerPoint who want to become productive in the
shortest possible time. Delegates should be proficient in using a PC with the Microsoft Windows operating
system, but no prior experience with PowerPoint is required.

Course Outline

Getting Started with Powerpoint
• Meeting Microsoft Office PowerPoint • Creating a Presentation • Working with Your Presentation • Editing
Your Presentation • Arranging Slides • Getting Help in PowerPoint

Understanding & Customising the PowerPoint Interface
• Getting Acquainted • The Quick Access Toolbar • Tabs and Groups • Customising the Ribbon

Creating and Formatting Presentations
• Using Templates • Working with Text Boxes • Basic Editing Tools • Formatting Text: Effects; Fonts and
Spacing • Formatting Text: Alignment; Indenting and Lists • Advanced Text Tools

Adding Shapes and Art to Your Presentation
• Drawing Shapes • Working with Shapes • Working with Text and Shapes • Advanced Shape Tasks

Viewing and Printing Your Presentation
• Using Layouts and Views • Viewing a Slide Show • Preparing Your Presentation • Printing Your
Presentation

Adding the Finishing Touches
• Research Tools • Using Themes and Backgrounds • Creating Slide Transitions • Creating Basic Animations
• Creating Advanced Animations
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MICROSOFT OFFICE POWERPOINT ADVANCED

COURSE CONTENT

Course Aims

This intensive hands-on one-day training course has been designed to provide delegates with a solid
understanding of advanced PowerPoint tools and concepts in order to bring their ability to create powerful
presentations to an expert level.

Who Should Attend

Users with a good understanding of Microsoft PowerPoint 2007 or who want to expand on their capabilities
in a short space of time. Delegates should have a good working knowledge and understanding of the
concepts covered in the Introduction course.

Course Outline

Managing PowerPoint Files
• Using Windows Explorer within PowerPoint • File Management Tools • Using Presentation Tools:
Optimisation and Compression • Using Presentation Tools: Inspection and Checking

Working with Pictures
• Inserting Pictures • Editing Pictures • Manipulating Pictures • Formatting Pictures • Managing Pictures

Adding Multimedia to a Presentation
• Inserting Video Files • Editing Video Files • Inserting Audio Files • Editing Audio Files

Adding Tables Charts and Diagrams
• Inserting Tables • Editing Tables • Formatting Tables • Inserting Charts • Inserting SmartArt • Formatting
SmartArt

Setting up Slide Masters
• Creating a Slide Master • Using Placeholders • Using Slide Masters • Using Hand-out Masters • Using
Notes Masters

Reviewing Presentations
• Using Comments • Reviewing a Presentation

Creating Advanced Types of Shows
• Setting up Your Show • Presenting Your Show • Creating a Custom Show • Advanced Presentation
Techniques
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MICROSOFT OFFICE PUBLISHER INTERMEDIATE

COURSE CONTENT

Course AimsThis intensive, hands-on one-day training course has been designed to give a solid understanding ofPublisher's large collection of templates and required basic skills, to set delegates on the path towardscreating professional publications with ease.
Who Should AttendThe course is intended for people with a basic understanding of Microsoft Windows and MicrosoftWord who need to learn how to use Microsoft Publisher to create, layout, and edit publications. Note:Delegates should be familiar with using a PC in the Windows environment and be able to use Windowsto manage information on their computers.
Course OutlineGetting Started with Publisher• Identify the Components of the Publisher Interface • Customize the Publisher Interface • Create aBasic Publication • Add Content to a PublicationModifying the Layout and Structure of a Publication• Import Text into a Publication • Organize Text Boxes and Picture Placeholders in a Layout • Controlthe Display of Content in Text Boxes • Insert Common Layout Elements • Use Building BlocksFormatting Text in a Publication• Format Text • Format Paragraphs • Apply Paragraph Styles • Apply SchemesEditing Content in a Publication• Edit Text in a Publication • Present Content in Tables • Review Text in a Publication • Insert Symbolsand Special CharactersFormatting Graphics in a Publication• Customize the Appearance of Pictures • Add Graphical Objects to a PublicationPreparing a Publication for Distribution• Check the Design of a Publication • Save a Publication for Distribution • Preview and Print aPublication • Send a Publication by Email
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MICROSOFT OFFICE WORD INTRODUCTION

COURSE CONTENT

Course Aims

This intensive one-day training course is designed to enable users to get to grips with the basic features of
Microsoft Word , including a thorough treatment of the new 'Ribbon' interface, introduced with Word 2007. It
is entirely 'hands on', so delegates will get practice in using the software in a real life and practical way.

Who Should Attend

The course is intended for new users of Microsoft Word who want to become productive in the shortest
possible time. Delegates should be proficient in using a PC with the Microsoft Windows operating system,
but no prior experience with Word is required.

Course Outline

Getting Started With Word

• Meeting Microsoft Office Word • Creating a Document • Navigating in Your Document • Doing More with
Your Document • Working with Your Document • Getting Help in Word

The Word Interface

• Getting Acquainted • The Quick Access Toolbar • Tabs and Groups • The Home Tab • The Insert Tab • The
View Tab

Advanced Tabs and Customisation

• The Page Layout Tab • The References Tab • The Mailings Tab • The Review Tab • Contextual Tabs •
Customising the Ribbon

Creating Documents

• Creating a New Document • Selecting Text • Moving Text • Applying Advanced Text Effects

Doing More with Text

• Fonts on the Home Tab • The Font Dialog • Using Tabs • Paragraph Options

Viewing and Printing Your Document

• Using Layouts and Views • Basic Viewing Tools • Advanced View Tools • Preparing Your Document •
Printing a Document
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MICROSOFT OFFICE WORD INTERMEDIATE

Course Aims

This intensive, hands-on one-day training course has been designed to give delegates a solid understanding
of more advanced tools and concepts used in Word , in order to increase their knowledge and productivity.

Who Should Attend

Users with a basic understanding of Microsoft Office Word who want to consolidate and expand on their
knowledge of the basic features in a short space of time. Delegates should have a good working knowledge
and understanding of the concepts covered in the Introduction course.

Course Outline

Managing Your Documents
• Using Windows Explorer within Word • Saving Your Files • Finishing Your Files • Making Word Work
Backwards • Viewing Your Files

Using Formatting Tools
• Working with Templates • Using Bullets and Numbering • Using the Paragraph Dialog • Using Delineation
Tools • Working with Pages • Adding Hyperlinks

Creating Headers and Footers
• Creating Basic Headers and Footers • Using the Header & Footer Tools – Design Tab • Inserting Page
Numbers • Doing More with Headers and Footers

Working with Pictures
• Inserting Pictures • Editing Pictures • Doing More with Pictures • Formatting Pictures • Managing Pictures

Working with Shapes
• Drawing Shapes • Working with Shapes • Working with Text and Shapes • Advanced Shape Tasks

Performing a Mail Merge
• Using the Mail Merge Wizard • Performing a Manual Mail Merge • Sending a Document Electronically
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MICROSOFT OFFICE WORD ADVANCED

Course Aims

This intensive hands-on one-day training course has been designed to provide delegates with a solid
understanding of advanced Word tools and concepts in order to increase their knowledge and productivity.

Who Should Attend

Users with a good understanding of Microsoft Word who want to expand on their capabilities in a short
space of time. Delegates should have a good working knowledge and understanding of the concepts
covered in the Introduction and Intermediate courses.

Course Outline

Managing and Reviewing Documents
 Using Comments • Tracking Changes • Combining Multiple Versions of Documents •
Creating an Outline

Working with Reference Tools
 • Creating a Table of Contents • Creating References within a Document • Creating a
Bibliography • Creating Index and Reference Tables • Creating References to Other Documents

Using Time Saving Tools
 • Using Language Tools • Inserting Pre-Defined Text • Using the Navigation Pane

Working with Advanced Graphics and Objects
 • Inserting Text Boxes • Inserting WordArt • Creating SmartArt • Editing SmartArt • Using
Building Blocks and Quick Parts

Creating Tables
 • Inserting Tables • Editing Tables • Formatting Tables • Working with Table Data

Creating Equations and Charts
 • Working with Equations • Creating Charts • Formatting Charts • Analysing Chart Data
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MICROSOFT OFFICE EXCEL INTRODUCTION

Course Aims

This intensive one-day training course is designed to let users get to grips with the main features of Microsoft
Office Excel , including a thorough treatment of the new 'Ribbon' interface, introduced with Excel 2007. It is
entirely 'hands on', so those attending will get practice in creating and modifying actual spreadsheets.

Who Should Attend

The course is intended for new users of Microsoft Excel who want to become productive in the shortest
possible time. Delegates should be proficient in using a PC with the Microsoft Windows operating system,
but no prior experience with Excel is required.

Course OutlineGetting Started with Excel
• Starting Out • About Workbooks • Exploring your Workbook • Getting Help with ExcelThe Excel Interface
• The Quick Access Toolbar and File Menu • The Home Tab • The Insert Tab • The Page Layout Tab • The
Formulas Tab • The Data Tab • The Review TabExcel Basics
• Working with Excel • Basic Excel Features • Moving your Data • Smart Tags and Options Buttons • Editing
ToolsEditing your Workbook
• Modifying Cells and Data • Cell Formatting • Enhancing a Worksheet’s AppearancePrinting and Viewing your Workbook
• Using the View Tab • Managing a Single Window • Managing Multiple Windows • Printing your WorkbookWorking with Charts
• Creating Charts • Selecting Chart Data • Working with Chart Options
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MICROSOFT OFFICE EXCEL INTERMEDIATE

Course Aims

This hands-on one-day training course has been designed to give delegates a solid understanding of more
advanced tools and concepts used in Excel , in order to increase their knowledge and productivity.

Who Should Attend

Users with a basic understanding of Microsoft Excel who want to consolidate and expand on their
knowledge of the basic features in a short space of time. Delegates should have a good working knowledge
and understanding of the concepts covered in the Introduction course.

Course OutlineAdvanced File Tasks
Using Windows Explorer within Excel • Saving your Files • Using File Management Tools, Part One • Using
File Management Tools, Part TwoWorking with Functions and Formulas
Using Formulas in Excel • Exploring Excel Functions • Using Functions in Excel • Working with Names and
Ranges • Working with Array FormulasManaging Tables
Working with Tables • Working with Records and Fields • Working with Tables and Filters • Using Excel as a
DatabaseAdding the Finishing Touches
Research Tools • Using Themes • Adding Text Boxes • Inserting Pictures and ClipArt • Editing PicturesShowing Data as a Graphic
• Inserting SmartArt • Formatting SmartArt • Adding Symbols, Equations, and Shapes • Sparklines • Editing
Sparklines
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MICROSOFT OFFICE EXCEL ADVANCED

Course Aims

This intensive hands-on one-day training course has been designed to provide delegates with a very
advanced set of Excel tools and concepts in order to further increase their knowledge and productivity.

Who Should Attend

Users with a solid understanding of, and experience with, Microsoft Excel who want to increase their ability
in a short space of time. Delegates should have a good working knowledge and understanding of the
concepts covered in the Introduction, Intermediate and Advance courses.

Course OutlineAdvanced Conditional Formatting
• Editing Standard Formatting Rules
. Input Validate rules
• Using Formulas in Conditional FormattingUsing Form Controls and Templates
• Using Form Controls
• Creating TemplatesMacrosAdvanced CalculationsGoal seek, consolidate and scenariosAdvanced Lookup Functions
•Using Hlookup and VLookup Functions
Using the Index Function
• Using the Match Function
• Using Index and Match Together
• Using the Indirect FunctionAdvanced Functions
• Using Error Functions
• Using Logical Functions
• Using Array Formulas
• Using Rounding FunctionsAdvanced Pivot Table Tools
• Importing Pivot Table Data
• Calculated Fields in Pivot Tables
• Showing Pivot Data as a Percentage
• Creating Custom Pivot Tables Styles
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MICROSOFT OUTLOOK 2007 INTRODUCTION

COURSE CONTENT

Course Aims

This intensive, hands-on one day training course is designed to teach delegates how to identify the
components of the Outlook environment, compose, send, responding to and organise email messages, use
folders, manage contacts and schedule appointments, meetings, tasks and notes.

Who Should Attend

New, intending or existing users of Microsoft Outlook 2007 who want to master the basic features and learn
best practice in order to become more productive in their communications and organisation. Note: Delegates
should be proficient in using a PC with the Microsoft Windows operating system, but no prior experience with
Microsoft Outlook is required.

Course OutlineGetting Started with Outlook
 Explore the Outlook Interface • Send a Simple Message • Read Messages • Reply to and Forward a Message• Print a Message • Delete a MessageComposing Messages
 • Address a Message • Format a Message • Check Spelling and Grammar • Attach a FileOrganizing Messages
 • Open and Save an Attachment • Flag a Message • Organize Content with FoldersManaging Contacts
 • Add a Contact • Find the Geographical Location of a Contact • Manage ContactsScheduling Appointments
 • Explore the Outlook Calendar • Schedule an Appointment • Assign Categories and Edit AppointmentsScheduling Meetings
 • Schedule a Meeting • Reply to a Meeting Request • Propose a New Meeting Time • Manage Meetings •Print the CalendarManaging Tasks and Notes
 • Create a Task • Edit and Update a Task • Create a Note • Edit a Note • Display a Note on the Desktop
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MICROSOFT OUTLOOK 2007 INTERMEDIATE

COURSE CONTENT

Course AimsThis intensive, hands-on one day training course is designed to teach delegates how to customise their Outlookenvironment, calendar, mail, folders, and also track, share, assign, and quickly locate items within Outlook.
Who Should AttendExisting users of Outlook 2007 who wish to further develop their understanding of the software and improvetheir performance at work. Note: delegates must have a thorough understanding of, and experience in, thesubjects covered in the Introduction course.
Course OutlineSetting Calendar Options• Set Work Days and Times • Display an Additional Time Zone • Set Availability OptionsCustomizing Message Options• Modify Message Settings • Modify Delivery Options • Change the Message Format • Notify Others that You WillBe Out of the Office • Create a Distribution List • Insert a HyperlinkTracking Work Activities Using the Journal• Automatically Record a Journal Entry • Manually Record a Journal Entry • Modify a Journal EntryManaging Tasks• Assign a Task • Reply to a Task Request • Send a Task Update • Track Assigned TasksSharing Folder Information• Specify Folder Permissions • Delegate Access to Folders • Access Another User's Folder • Send CalendarInformation in an Email MessageCustomizing the Outlook Environment• Customize the Toolbar • Create a New Toolbar • Customize the Menu Bar • Customize the Quick Access Toolbar• Customize the To-Do Bar • Create a Folder Home PageLocating Outlook Items• Sort Messages Using Multiple Criteria • Find Messages • Find Outlook Items Using Multiple Criteria • FilterMessages • Organize Messages • Manage Junk EmailWorking with Public Folders• Create a Public Folder • Add Users to a Public Folder • Post Information in a Public Folder • Send an EmailMessage to a Public Folder
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MICROSOFT OUTLOOK 2007 ADVANCED

COURSE CONTENT

Course AimsThis intensive, hands-on one day training course is designed to teach delegates how to personalize email,organize Outlook items, manage Outlook data files, share and link contacts, save and archive email, create forms,and work offline and remotely.
Who Should AttendExisting users of Outlook 2007 who wish to use the advanced features of outlook to improve their productivityand effectiveness. Note: delegates must have a thorough understanding of, and experience in, the subjectscovered in the Introduction and Intermediate courses.
Course OutlinePersonalizing Your Email• Apply Stationery and Themes • Create a Custom Theme • Create Signatures • Modify Signatures • ConfigureEmail Message Security SettingsOrganizing Outlook Items• Group Items • Create Search Folders • Apply Conditional FormattingManaging Outlook Data Files• Create a Data File • Add Outlook Data Files to a Mail Profile • Change Data File SettingsWorking with Contacts• Forward Contacts • Edit an Electronic Business Card • Export Contacts • Perform a Mail Merge • Link Items toBusiness Contact ManagerSaving and Archiving Email• Save Messages in Alternate Formats • Archive Messages • Protect Personal FoldersCreating a Custom Form• Add Form Fields • Save a Form as a Template • Test a FormWorking Offline and Remotely• Make Folders Available Offline • Configure RPC Over HTTP • Download Selected Messages • Publish CalendarInformation to Office Online
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MICROSOFT OUTLOOK 2007 NEW FEATURES

COURSE CONTENT

Course AimsThis intensive, hands-on one-day training course introduces the new features and functionality in the latestversion of Microsoft Outlook. There have been substantial changes to the user interface in this databaseapplication, and this course will help delegates get proficient in the shortest possible time.
Who Should AttendThe course is designed for experienced Outlook users who have worked with earlier versions of MicrosoftOutlook , and who have or are planning to upgrade to Microsoft Outlook 2007. Ideally delegates should also havesome familiarity with the Internet. This course covers the commonly used new features for a typical user.
Course OutlineGetting Started• Starting Out • Interacting with Outlook • The New Interface, Part 1 • The New Interface, Part 2 • Using theOutlook Panes • Getting Help in OutlookUsing E-mail• Answering E-mail • Doing More with E-mail • Polishing your Message • Adding Word Elements • AddingOutlook ElementsAdvanced E-mail Features• Advanced Calendar Options • Advanced Mail Options • Advanced Contact Management Options • Signaturesand Stationery • RSSMore Advanced E-mail Features• Using Categories • Linked Items • Publishing your Calendar • Using the Account Settings WindowSecurity and Search Tools• Security Tools • The Trust Center, Part 1 • The Trust Center, Part 2 • Instant Search
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DREAMWEAVER
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HTML PROGRAMMING INTRODUCTION

COURSE CONTENT

A ONE-DAY TRAINING COURSE

COURSE AIMSThis hands-on one day training course is designed to provide the basic foundation necessary to createWeb pages using HTML.
Course Outline

Overview of HTML• Overview • Introduction to HTML • Creating an HTML document
Formatting text with HTML• Paragraph formatting with HTML • Character formatting with HTML • Comparing procedural anddescriptive formatting
Adding local and remote links• Adding local links • Adding remote links • Adding internal links with the named anchor tag
Adding graphics and sound• Linking to and embedding graphics • Linking to multimedia files
Creating lists in HTML• Creating lists • Creating nested lists
Creating tables in HTML• Creating and modifying tables • Creating advanced table elements
Setting body and background attributes• Setting backgrounds and text colors
Web page design guidelines• Web page style considerations
Adding links to other Internet services• Links to non-Web Internet services
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HTML PROGRAMMING INTERMEDIATE

COURSE CONTENT

Course AimsThis hands-on one day training course is designed to provide some of the more advanced HTMLelements and techniques. Delegates will learn several new topics including customizable tables andforms.
Who Should AttendThe course is intended for existing users of HTML who want to use more advanced features in order toincrease their productivity and effectiveness. Delegates should have a good working knowledge andunderstanding of the concepts covered in the Introduction course.
Course Outline

Advanced tables• Creating nested tables • Using tables for page layout
Graphics• Incorporating graphics into a document • Creating and using imagemaps
Creating forms• Introduction to forms
Advanced forms• Using advanced input types • Setting input type attributes • Creating a text area • Creating form listboxes
Frames• Overview of frames • Creating frames • Applying frame attributes • Using nested framesets
Dynamic and interactive documents• Interactive Web pages • JavaScript in HTML documents • Java in HTML documents
Cascading Style Sheets (CSS-1)• Introduction to style sheets (CSS-1) • Working with style sheet properties and selectors • Linkedstyle sheets
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ADOBE DREAMWEAVER INTRODUCTION

COURSE CONTENT

Course AimsThis intensive, hands-on one day training course is designed to teach delegates how to design, build, and uploada website.
Who Should AttendThis course is intended for novice web designers, web developers, website designers, and graphic artists withsome programming background who need to build simple websites and want to utilize the features of AdobeDreamweaver CS5. Note: Delegates should be proficient in using a Windows PC, and be familiar with HTML andbasic CSS.
Course OutlineGetting Started with Dreamweaver• Identify the Basic Concepts of Web Design • Locate Dreamweaver Interface Elements • Customize the InterfaceInitiating a Website• Identify the Elements of a Project Plan • Determine the Workflow of a Web Project • Define a Website • Create aDocumentDesigning Web Pages• An Introduction to Cascading Style Sheets • Format a Web Page • Identify Copyright and Citation Requirements• Insert Images • Insert Tables • Import Data from Other Applications • Organize Files and FoldersCreating Reusable Site Assets• Create and Use Library Items • Update Library Items • Use Snippets • Create a TemplateWorking with Links• Create Hyperlinks • Create Anchors • Create Email Links • Create Image Maps • Create Image Link RolloversUploading a Website• Validate a Website • Upload Files onto a Site
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ADOBE DREAMWEAVER INTERMEDIATE

COURSE CONTENT

Course AimsThis intensive, hands-on one day training course is designed to teach delegates how to develop professional-looking web pages using the Adobe Dreamweaver application.
Who Should AttendThis course is intended for web developers, designers, and administrators who are familiar with the basic toolsand features of Adobe Dreamweaver and want to expand on existing knowledge to gain intermediate toadvanced skills for creating and maintaining more robust interactive websites. Note: Delegates should have agood working knowledge and understanding of the concepts covered in the Introduction course.
Course OutlineWorking in Code View• Use Coding Tools • Search for and Replace Code • Add Design Notes and CommentsFormatting with Advanced CSS Techniques• Use External Style Sheets • Create a Layout Using CSS • Apply Rollover Effects Using CSSWorking with AP Elements• Create AP Elements • Control AP ElementsWorking with Spry Elements• Use Spry Interface Widgets • Use Spry Data SetsCreating a Form• Set Up a Form • Add Form Elements • Validate a FormIntegrating External Files with Dreamweaver• Integrate Photoshop Images in Dreamweaver • Insert Media Objects • Integrate XML-Based Data
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ADOBE DREAMWEAVER ADVANCED

COURSE CONTENT

Course AimsThis intensive, hands-on one day training course is designed to teach delegates how to develop professional-looking web pages using the Adobe Dreamweaver application.
Who Should AttendThis course is intended for web developers, designers, and administrators who are familiar with the basic toolsand features of Adobe Dreamweaver and want to expand on existing knowledge to gain intermediate toadvanced skills for creating and maintaining more robust interactive websites. Note: Delegates should have agood working knowledge and understanding of the concepts covered in the Introduction course.
Course OutlineEstablishing Database Connectivity• Connect to a Server • Identify the Components of a Database-Driven Site • Create a Connection to the DatabaseWorking with Recordsets• Create Recordsets • Display Records • Navigate Through RecordsetsCreating Interactive Page Elements• Create Master and Detail Pages • Create Search and Results Pages • Use Dynamic Form ElementsAdministering Records• Insert Records • Edit Records • Delete RecordsCreating User Authentication Systems• Create User Registration Forms • Secure Web PagesAdministering Websites• Transfer Files to Servers • Manage Websites
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SAGE
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SAGE 50 ACCOUNTS : INTRODUCTION

COURSE CONTENT

Course AimsThis training course provides the basic knowledge required to operate the Sage 50 Accounts package. It is anextremely 'hands-on' course : delegates will be maintaining ledger accounts, inputting opening balances andprocessing journals through to production of VAT and relevant management reports.In addition, delegates will cover bank transactions and reconciliation, plus the maintenance and use of the Sales,Purchase and Nominal Ledgers and the Product file including stock control and the production of invoices.In all, it provides a solid background for the day-to-day use of the Sage 50 Accounts package in a commercialenvironment.
Who Should AttendAll Accounts staff who need to learn how to use the Sage 50 Accounts accounting package.Note: Participants should be competent in operating a PC.
Course OutlineProgramme Basics• Starting Sage 50 Accounts • The main programme window • Modules, windows and views • Getting help •Exiting Sage 50 AccountsGetting Started• Getting started • Restoring data for the first time • Setting the financial year • Backing up for the first timeAccount Names & Numbers• Debit and credit • Double entry book-keeping • Viewing the accounts list • Printing the current list • Viewingand printing Nominal List report • Account ranges • Changing account names • Control accountsBank Entries• Bank Receipts • Bank PaymentsFinancials• The financial state of the company • The Trial Balance report • The Profit and Loss report • The Balance SheetCustomers• The Customers module • Entering a new customer • The Customer Record Wizard • Adding more customers •About selecting customers • Editing customer details • Customer delivery addresses • Customer address listsSuppliersService Invoices• The Invoice window • Service Invoices • Printing invoices • Updating ledgers • Viewing customer and invoiceinformation • Re-printing the invoiceProducts• Products • Adding new products • The Product Record window • Non-Stock and Service itemsStock Control• Stock adjustments in • Stock adjustments out • Stock returns • Product activity • Stocktaking • Re-order levels •The Product DashboardProduct Invoices• Product Invoices • Adding an invoice with a customer delivery address • Adding a further invoice • Mix andmatch invoicing • Printing the invoices • Changing an invoice • Updating the ledgers • Adjustments inProduct Credit NotesReviewing your Accounts• The financial state of your company
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Sending Statements• Customer Dashboard • Account balances • Aged debtors analysis • StatementsCustomer Receipts• Customer Receipts • Automatic allocation of receipts • Manual allocation of receipts • Partial allocation ofreceipts • Giving a discount • Payments on accountCustomer ActivityPurchase Invoices• Supplier details • Batch invoices • Supplier account balancesSupplier Payments• Payments to suppliers • Making a payment • Printing remittance advice notes • Printing cheques • SupplieractivityMore about the Nominal Ledger• Journal entries • Nominal code activity • Nominal Ledger Graph • Nominal recordsMore about Bank Accounts• Bank transfers • Combined payments • Petty cash transactionsBank ReconciliationRecurring Entries• What are recurring entries? • Adding new recurring entries • Adding a receipt • Adding journal credits anddebits recurring entries • Setting up a bank transfer recurring entry • Editing an entry • A recurring entryprocessed weekly • Processing recurring entries • Suspending postings • Deleting recurring entriesVAT Returns• Notes on VAT returns • Producing a VAT return • VAT adjustments • Printing the VAT return • Reconciling theVAT transactions • Updating the VAT account referencesSimple Reports & Information• Information • Reports
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SAGE 50 ACCOUNTS : INTERMEDIATE

COURSE CONTENT

Course Aims

This training course takes participants beyond the basics of day-to-day bookkeeping, and into the use of
Sage 50 Accounts for prepayments, accruals, depreciation, contra payments and global changes. It alsodeals with pricing options and currencies (including the Euro). This is a very 'hands-on' course : delegates
will use the package to carry out tasks, and will acquire practical experience as well as an enhanced
knowledge of Sage 50 Accounts and the accounting principles behind it.

Who Should Attend

All Accounts staff who want to move beyond the basics of the Sage 50 Accounts accounting package.
Note: Participants should be competent in operating a PC, with a good basic knowledge of the package.

Course OutlinePrepayments & Accruals• What are prepayments and accruals? • Setting up prepayments • Setting up accruals • Processing prepaymentsand accruals • Deleting prepayments and accrualsFixed Assets & Depreciation• What are fixed assets? • Depreciation methods • Entering a new fixed asset • Entering an existing asset •Depreciating assets • Asset valuation • Asset reports • Writing off an assetDelivery Addresses• Delivery addresses • Adding delivery addresses • Setting the invoice & order defaults for delivery addresses •Editing a customer delivery addressEntering Purchase Orders• Purchase order processing • The Purchase Order Processing window • Entering a purchase order for productitems • Entering a non-product purchase order • Entering long descriptionsPurchase Order Skeletons• What is a purchase order skeleton? • Using a non-recurring purchase order skeletonProcessing Purchase Orders• Printing purchase orders • Putting purchase orders on order • Deliveries • Deliver - complete deliveries • GRN -Goods Received Notes • Amending deliveries • Changes made to the accounts data • Creating purchase invoicesfrom purchase orders • Purchase order reports • Deleting ordersProduct Records & Purchase Orders• Product recordsBOMs & Product Transfers• What are BOMs? • Case studies • Checking availability of components • Stock transfers • Product reportsProduct Pricing Options• Pricing options • Setting a special customer price • Creating customer price lists • Changing a cost price •Moving a customer from one price list to another • Deleting price lists • Price list reportsEntering Sales Orders• Sales order processing • The Sales Order Processing window • Sales order - product items • Multiple line salesorders, discounts, goods not in stock • Non-product sales ordersRecurring Sales Order Skeletons• Sales order skeletons • Editing a sales order skeleton • Processing a recurring sales order skeleton • Editing thefrequency of a recurring sales order • Deleting a sales order skeleton
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Processing Sales Orders• About sales order processing • Printing sales orders • Allocating stock • Using the ShortFall Generator • Salesorder reports • Recording despatches • Changing a sales order • Manual processing • Partly allocated orders •Cancel, hold and unallocate • Deleting ordersMore about Sales Invoices• Checking sales invoices • Printing invoices • Updating ledgersCredit Control• Credit control basicsUsing the Search Option• The Customers window • Using the Search optionStatements & Account Letters• Sending statements • Accounts letters • Disputed invoicesCustomer Refunds• Entering the overpayment • Checking the customer activity • Processing the customer refundLate Payment Legislation• What is the late payment legislation? • Setting up your system for late payment charges • Adding an invoice •Charging customers for late paymentWriting Off Bad Debts• Writing Off Bad DebtsThe Sage Task Manager• Opening the Sage Task Manager • Entering tasks • Closing the Sage Task ManagerPaying Bills using the Sage Task Manager• Entering bills into the Sage Task Manager • Paying bills using the Sage Task ManagerCash Flow Forecasting• Showing the Cash Flow windowVersions of Sage 50 AccountsNOTE: Content may vary slightly between versions (eg V10, V11, etc) or applications (Accountant, AccountantPlus, Financial Controller). These differences are usually if little significance and do not affect the core skillsacquired during the course.Because we need to cater for a wide range of users, most of whom do not use the latest version, we deliver thecourses on a version that is 2-3 years old.
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SAGE 50 ACCOUNTS : ADVANCED

COURSE CONTENT

Course AimsThis training course takes participants into advanced use of Sage 50 Accounts, including subjects such asbudgets, quotes, proforma invoices, currencies, batch payments and the audit trail. It is a very 'hands-on' course :delegates will use the package to carry out tasks, and will acquire practical experience as well as an enhancedknowledge of Sage 50 Accounts and the accounting principles behind it.
Who Should AttendAll Accounts staff who need to learn how to use advanced features of Sage 50 Accounts. Note: Participants shouldbe competent in operating a PC, with a solid working knowledge of the package.
Course OutlineImporting Data• Preparing data for importing • Importing customer recordsSetting up Departments• Why use departments? • Setting up departmentsSetting Budgets• Budgets • Entering nominal code budget details • Advanced budgeting method • Setting your budget bydepartment • Checking the departmental budgets • Using one year’s actuals for the next year’s budgetSetting up Discounts• Customer discounts • Discount by invoice value • Discount by product quantity • Applying a customer discount• Settlement discounts • Discounts by invoice item line • Net value discounts • Product discount schemedescriptionsQuotations• About quotations and converting quotations • Creating a product quotation • Creating a service quote •Printing quotationsConverting Quotations• Winning and losing quotations • Winning a quotation • Losing a quote • Retrieving a lost quotation andwinning itPro-forma Invoices• Creating a pro-forma invoice • Processing the payment on account • Creating the invoiceThe Euro & Other Foreign Currencies• The euro • Setting up the Foreign Trader option • Setting up the currency table • Foreign currency bankaccountsInvoicing in Euros• Creating a sales invoice with a euro total • Adding a euro sales invoiceReceiving Payments in Euros• Updating the currency table • Receiving euro payments • How Sage 50 Accounts Professional has dealt with the
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exchange rate variancePaying Foreign Currency Invoices• Entering supplier invoices • Paying foreign currency invoices • Checking the supplier activity for exchange ratevarianceContra Entries• - What is a contra entry? • - Entering the purchase invoices for the customer/supplier • - Entering contraentriesBatch Payments• Entering the supplier invoices • Entering batch purchase payments • Printing chequesChanging Posted Records• Adding incorrect payments • Checking the audit trail • Using journal reversals • File maintenance • Checkingthe petty cash accountBatch Changes & Global Changes• What are batch changes? • What are global changes? • Changing specific recordsThe Opening and Closing Stock Wizard• Calculating the cost of sales • Using the Opening and Closing Stock WizardAnalysing Budgets & Departments• Analysing the budget • Analysing department sales & expenditureThe Audit Trail• What is the audit trail? • Viewing the audit trail • Printing the audit trail report • Clearing the audit trailReport Designer Basic Skills• About reports and layouts • Using the Report Designer • Basic skills • Customising a customer letter • Tooltipsand selecting objectsReport Designer More Skills• Opening an invoice form for editing • Customising the invoice • Using the customised invoiceThe Sage Report Wizard• Creating a new report • Changing the page setup • Saving the telephone list report • Accessing the new report •Deleting a reportProject Costing• What is project costing? • Setting up project costing • Using project costing • Analysing the project • Projectenquiry • Project credits • Raising the sales invoice • Completing the project • Project reportsSetting Passwords & Access Rights• Setting password access to Sage • Setting a company password • Setting up individual password protection
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SAGE ACT! CRM ADMINISTRATOR COURSE

What do I learn?

This is a more advanced course to help you maximise your knowledge and use of Sage ACT! It will help you
master everything you need to know about creating a new database and users, customising fields and layouts

Objectives

 Know how to create a new database, create and delete users and manage user passwords
 Understand how to customise database fields, including modifying existing fields or setting up new ones,

creating drop down lists and using field security
 Know how to use the Layout Designer to amend existing layouts and create new tabs
 Be able to customise menus, toolbars and the Navbar, including adding/removing icons and menu items
 Understand how to customise Smart tasks
 Become familiar with and customise ACT! Dashboards
 Know how to setup and use the Sage Accounting Integration, including importing and creating Sage

Accounts records
 Understand how to Import Sage Accounts products into ACT! and converting opportunities to sales orders /

invoices
 Be able to export from one ACT! Database to another ACT! Database
 Know how to deal with duplicate records and make global changes
 Understand how to use Database Maintenance including taking a backup.
 Be able to import and export data from Microsoft®Excel
 Learn how to customize ACT! reports using report designer
 Become familiar with Sage E-marketing and Business services tools.
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Sage ACT! Crm user course

What do I learn?

This is an introductory course that will help you understand and get the best out of Sage ACT! It includes

setting up contacts, lookups and searches, exporting data to Microsoft® Excel, activities and opportunities,

email, letter templates and how to mail merge.

Objectives

What will I learn by the end of this course?

 Be more familiar with navigation and what Sage ACT! can do for you
 Understand how to manage your contacts
 Know how to use lookups and searches
 Know how to use the Document tab, including editing, adding and mapping to spreadsheets
 Know more about Groups and Companies and how to use subgroups and divisions
 Understand how to schedule activities, including creating types and priorities, adding resources, contacts

and users and how to use activity reporting
 Understand the Opportunity process and how to manage opportunities from creation to closing, including

reports and pipeline management
 Be able to create letters, letter templates and understand how to use mail merge
 Understand how to use email integration
 Overview of database synchronisation.
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